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About These Release Notes

These Release Notes provide information that is not available in the printed 
documentation or the Help for Rational TestManager.

Trademarks and Copyrights

A complete online trademark and copyright information page for all Rational 
products resides in the /doc subfolder of your installation folder. The file is called 
copyright.html, and its default location is C:/Program Files/Rational/doc. 

Scope—Product Definition 

This release incorporates several enhancements to the Rational TestManager product.

Getting Started 

Installation Information and System Requirements 

You will find complete installation instructions and system requirements in Rational 
Testing Products Installation Guide, which is available as a printed book and electronically 
as a PDF file on the Rational Solutions for Windows Online Documentation CD, 
which also includes a version of the Acrobat Reader.

Installation Issues 

Evaluation Artifacts

Evaluation artifacts are not included as a part of this installation procedure. As a 
result, when you select the Evaluator option on the Software Use page of the Rational 
Software Setup program, sample data will not be installed.

To obtain the sample data, download the Rational Suite Tutorial from 
http://www.rational.com/documentation. 

New and Changed Features

The following new features have been added to Rational TestManager. For details, see 
the "What's New in Rational TestManager" topic in the TestManager Help.
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Enhanced Test Asset Management

Upgrading project assets

You can use the current version of Rational TestManager with a Rational project 
created using a previous version of the Rational Administrator (version 2001.A.04 or 
version 2001.03). Upgrading your project also lets you use the new features in this 
version of TestManager. 

Importing and exporting test assets

You can move or copy existing test assets between and within Rational projects, use 
third party tools to create importable versions of test assets, or use third party tools to 
analyze exported test assets.

Cutting, copying, and pasting test assets

You can cut, copy, and paste test case folders and test cases. You can also copy and 
paste test plans within Rational projects.

General Enhancements

Test Impact Analysis

If a test input changes, TestManager now informs you of the impact of that change on 
your test plan. For example, if a requirement changes in some meaningful way, you 
need to know which test cases in your test plans are affected so that you can update 
them to reflect requirement changes. TestManager automatically identifies and marks 
the affected test cases as “suspect” for you.

Enhanced filtering of Test Input Sources

The Test Input Adapter Extensibility feature of TestManager now supports the ability 
to save test input source filters and Test Case Coverage report filters. When you set a 
filter for a test input source, the last filter that you set persists in the Test Inputs 
window and Test Input Select dialog box. When you set a filter for a Test Case 
Coverage report, the Test Input Adapter saves the filter with the report.

New built-in test input type: Microsoft Excel 

You can now use one or more Excel spreadsheets as test input sources. This test input 
adapter can be useful in many ways. Many teams use Excel to manage information in 
their projects. For example, some teams may document requirements or capture 
project planning information in an Excel spreadsheet. In either case, the new Excel test 
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input adapter allows teams to track the testing effort with respect to their information 
in an Excel spreadsheet. Specifically, they could associate test cases with tasks defined 
in rows of a spreadsheet so that a coverage report could be generated to show 
progress or completion of those tasks. 

Defining test script options

You can now define test script and test script instance options that can be used by 
execution adapters and test scripts to control how a test script instance behaves as it 
executes. 

New Test Scripts window

You can now view all your test scripts sorted by type from the Test Scripts window. 
From this window you can perform test management operations on test scripts. You 
can also perform basic version control operations (check-in, checkout, etc.) on 
registered test script sources.

Defining test tool options

Lets you set test tool options to control how a particular test tool plays back a test 
script. You can define a test tool option in the test script execution adapter that you 
have written for a particular test tool. 

New actions in the test script and test input adapters

Test script adapter and test input adapter developers can now add their own custom 
actions, or commands. You can run these custom actions or commands in 
TestManager.

Enhanced Reporting

New performance testing reports

There are two new performance testing reports in TestManager: Command Data and 
Command Trace. Command Data reports let you identify the differences between 
expected and actual responses in a test run. They show the commands sent and the 
reponse data that is written to the test log. The Command Trace report lists the 
activity of a suite run and enables you to examine in detail unusual or unexpected 
events. This report formats raw data from the suite run without performing statistical 
analysis.
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Changes to the test case reports

Lets you run test case reports that display test case suspicion status. Using the test 
case suspicion feature you can track meaningful changes to test inputs so that you can 
update the associated test cases or their implementations. Also, TestManager now has 
several new pre-defined test case coverage reports.

Red Hat Linux Version 7.1 support 

Lets you run TestManager Agent software on Red Hat Linux version 7.1.

Improved license allocation of virtual testers

Lets you combine multiple non-pooled virtual tester packs. Thus, if you had a 100 
virtual tester pack and a 500 virtual tester pack, you could execute a single run of as 
many as 600 virtual testers. 

Enhanced Oracle support 

TestManager now supports Oracle 8 OCI playback, additional data types, and Oracle 
sessions in Robot recording and VU test script generation.

Late Changes to Documentation

Installing Rational Testing Products

The installation manual (Rational Testing Products Installation Guide) refers to the 
installation types as Typical, Custom/Full, Compact/Laptop, and Minimal. In this 
release, Minimal installation is now called Network installation.

Guidelines and Restrictions

Test Script Playback

General

■ If text being logged with the log_msg() function exceeds 60KB, either a crash 
occurs or the playback engine enters an infinite loop. Workaround: limit messages 
to be logged to 60KB.

■ At the end of a run, the playback engine removes temporary log files. In some 
cases where a network project is being used, a fatal 'Permission Denied' error 
message may occur, rendering the log useless. Workaround: use a local project file.
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VU

■ Playback of VU test scripts is not supported for Windows Me, Windows 98, or 
Windows 95, whether the system is a Local computer or Agent computer.

■ When VU test scripts are played back on HP-UX, AIX, or Solaris Agents, pass/fail 
status information is not available in the Test Log window.

Command Line 

■ Playback of command line test scripts is not supported for HP-UX and AIX 
Agents.

■ When running command line test scripts or custom test script types that use the 
command line adapter on Windows NT systems as Agents, TestManager may 
report test script failure even though the test scripts executed successfully. To 
avoid this, install Service Pack 5 or Service Pack 6a on the Agent.

Manual

■ Playback of manual test scripts is not supported on any Agent.

■ When playing back manual test scripts, be sure to dismiss the Manual Test dialog 
box before trying to terminate users.

Visual Basic

Test Script Services (TSS) support test script playback from a proxy TSS server. 
However, Visual Basic test scripts cannot be played back by proxy TSS servers.

Check Suite When Saving Option

When working with suites in TestManager, be sure to save a suite before checking it. 
Accordingly, the "Check suite when saving" option on the Create Suite tab of the 
Options dialog box should be cleared. 

F5 (Refresh All) Does Not Work in Test Asset Workspace

You can press the F5 key to refresh all in the Test Plan window and in the Test Input 
window. This key does not work in the Test Asset Workspace. You must right-click a 
folder in each of the Test Asset Workspace tabs or go to View > Refresh Workspace from 
the main menu to refresh all the Test Asset Workspace.
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Viewing Properties of VU Test Scripts

The Test Script Properties dialog box does not reference the Robot session from which 
the VU test script was generated. To view this information, go to the Session 
Properties dialog box in Rational Robot to look for the test script as a contained script.

Monitoring Options

Occasionally, Monitor menu items may be unavailable. To access monitoring options 
in this case, use the Monitor toolbar.

Resource Monitoring

■ Monitoring system resources during test runs is not supported for Windows Me, 
Windows 98, or Windows 95, Local or Agent.

■ In order to monitor resources on an Agent computer that is running AIX, you must 
install the bos.acct package on that agent.

Executing Test Cases on Agents

■ Windows Me and Windows 98 are considered equivalent when matching 
computer configurations against test case configurations.

■ When you choose a parallel selector in a suite, the option Use multiple computers to 
maximize test case coverage is checked by default. The functionality behind this 
option is disabled for this release. This affects not only configured test cases run in 
parallel on multiple computers, but also configured test cases run automatically.

This means that when running configured test cases in parallel on multiple 
computers, depending on test case order, all configured test cases can not be 
run even if computers matching defined configurations are available. To work 
around this, limit running configured test cases to one computer at a time, and 
repeat over the list of desired computers in sequential order.

Report Generation

General

■ TestManager provides a “previous” button allowing you to change the log 
selection after you have selected the virtual tester, script, and commandID filters to 
be used in generating a report. This causes a problem because the previous log is 
not closed and conflicts with the new log. Workaround: if you need to change the 
log selection after you’ve selected filters, start over rather than use the “previous” 
button.
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Command Data Report

This report includes data written to the log by emulation commands. However, there 
are some commands (testcase & emulate) that do not write data to the log in all cases. 
If a run consists only of emulation commands that wrote no data to the log, the 
Command Data report may fail to execute.

Status Report

The graph index (0-based) does not match the table index (1-based).

Response vs. Time Reports

The Show Resource dialog box for data points in the Response vs. Time report for a 
Performance Testing Report, refers to the MASTER computer. This should read Local 
computer.

SAP Limitations

The following list gives SAP testing limitations in TestManager:

■ UNIX Agents are not supported for the SAP protocol. 

■ The personalizing option (the multicolored circle in the upper right of SAPGUI) is 
not supported.

■ Multiple SAP sessions with a single client are not supported.

■ Only the active screen is rendered, while SAPGUI sometimes renders inactive 
screens.

■ The control box in table controls is not supported.

■ Transaction IQ03 is not supported.

■ Automatic logon load balancing, as performed by SAPLOGON.EXE and the SAP 
Session Manager, is not supported.

■ The Manager's Desktop functionality under the "Human Resources" menu is not 
supported.

BLOB Transfer Unsupported 

TestManager does not support BLOB (Binary Large OBject) transfer. If you are 
recording a Sybase or SQL Server session that transfers BLOB data, the connection is 
ignored and the generated test script does not refer to BLOB transfer activity.
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Suspended Users in Transactors 

When you monitor a TestManager suite (formerly called a LoadTest schedule), and 
suspend a virtual tester in an independent transactor, upon restarting, the tester will 
try to catch up on the missed transactions. If you suspend a virtual tester in a 
coordinated transactor, the remaining testers will pick up the slack and try to 
maintain the desired transactor rate. If the rate cannot be maintained, then as testers 
are restarted, they will try to catch up on the missed transactions.

Oracle Testing Limitations 

The following list gives Oracle testing limitations in TestManager:

■ Oracle 8 support is limited to API recording.

■ Oracle array support is also limited to API recording.

■ To play back Oracle 7 with Oracle 7 libraries on HP-UX, you must set the following 
environment variable before invoking TestManager:

RT_MASTER_USE_STATE_FOR_SQL

Set the variable in the Environment tab of the System Properties Control Panel.

ODBC Limitations 

When playing back a SQL statement that generates multiple result sets, TestManager 
logs only the data for the first fetch. The other fetches show the number of rows 
returned, but does not log the data actually returned.

If a sqlfetch_cursor is run multiple times in a row with ALL_ROWS, and expect 
rows 0, an error for the second sqlfetch_cursor is generated stating:

ERROR -1:  {error} STATE=S1010, CODE=0, MSG=[Microsoft][ODBC Driver 

Manager] Function sequence error

When logging data returned from sqlfetch_cursor, sometimes the data is 
truncated and the next SQL command appears on the same line as a row of data. This 
is a logging problem only; the test script is executing correctly.

Named Pipes Unsupported for Network Recording

Named pipes are not supported for network recording.

Visual Basic and Java Test Scripts

Generated Visual Basic test scripts do not pass script line numbers to TestManager. As 
a result, the TestManager Script view feature (the Script check box under Tools > 
Options) does not work with generated Visual Basic test scripts. If you manually add 
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method calls to your Visual Basic and Java test scripts that pass test script line 
numbers to TestManager, the Script view will work. The relevant methods are 
TSSMonitor.PositionSet (Visual Basic) and TSSMonitor.positionSet (Java).

Setting the Madge Token Ring Card to Gather Traffic Statistics 

For Windows NT only, if you are using a Madge token ring card for network 
recording, make sure that the Traffic Statistics Gathering option is set to enabled. To 
enable this option, click Start > Settings > Control Panel, and click the Network icon. Then 
click the Adapters tab, click the Properties button, and enable the Traffic Statistics 
Gathering option. 

About PeopleSoft Certificates

When TestManager creates test scripts that contain PeopleSoft traffic (Tuxedo or Jolt), 
TestManager automatically correlates any PeopleSoft certificate information required 
for proper client authentication during playback. The correlations take the form of 
string variables, declared with the prefix psft_cert, and various operations on 
them. The following code shows a typical example of certificate correlation in a 
PeopleSoft/Jolt test script:

1  sock_send

2    jolt_request(0, jolt_sessionid_1, jolt_handlerid_1, 3,

3      jolt_dataxfer(jolt_sessionid_1, JOLT_CALL_RQST,

4        jolt_setatt_name("GetCertificate") +

5        jolt_setatt_version(1) +

6        jolt_setatt_flags(4) +

7        jolt_setatt_data(

8          jolt_setpar_carray(1,

9 "`000000480102030400000000000002bcffffffff0000001f0004`SCTX"

10 "`0a`JavaClient`02`PS`02`PS`00000000000000150008`SCertReq`0"

11            "2`PS`02`PS`00`"))));

12

13  sock_nrecv ["suzy027h"] jolt_response_header();

14  sock_nrecv ["suzy027b"] jolt_response_body();

15  { string psft_cert_1; }

16  psft_cert_1 = "`" + substr(mixed2hexstring(jolt_getpar_carray(1)), 

72, 32) +

17      "`";

18  set Think_avg = 230;

19

20  sock_send

21    jolt_request(0, jolt_sessionid_1, jolt_handlerid_1, 4,

22      jolt_dataxfer(jolt_sessionid_1, JOLT_GETDEF_RQST,

22        jolt_setatt_repname("SVC`2f`StmGetTimeOut")));
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23

24  sock_nrecv ["suzy028h"] jolt_response_header();

25  sock_nrecv ["suzy028b"] jolt_response_body();

26  set Think_avg = 240;

27

28  sock_send

29    jolt_request(0, jolt_sessionid_1, jolt_handlerid_1, 5,

30      jolt_dataxfer(jolt_sessionid_1, JOLT_CALL_RQST,

31        jolt_setatt_name("StmGetTimeOut") +

32        jolt_setatt_version(1) +

33        jolt_setatt_flags(4) +

34        jolt_setatt_data(

35          jolt_setpar_carray(1,

36 "`0000005a0102030400000000000002bcffffffff0000002f0004`SCTX"

37 "`0a`JavaClient`02`PS`02`PS`10`"+ psft_cert_1 +

38 "`00000000000017000e`SGetTimeOutReq`02`PS"))));\

In lines 15 and 16 a certificate correlation variable, psft_cert_1, is declared and 
assigned a value based on the contents of a previous Jolt response message. The 
variable is then properly applied to the contents of a subsequent Jolt request message 
in line 37.

Because this feature is necessary for proper playback of PeopleSoft test scripts, do not 
change the contents of the certification correlation variables or change the variable's 
position within the context of the surrounding message data. Doing so improperly 
may cause corrupt messages to be sent to the application-under-test, leading to 
unpredictable results. Should correlation variable manipulation be necessary, 
however, all automatically scripted variables represent 16 bytes of certificate data, in 
hexstring form, delimited by single backquotes ("`"), for a total of 34 text characters (16 
* 2 + 2). For example, "`664d689999999999c99a9ac9c9c9c9c9`".

Testing CORBA Applications

To test CORBA applications with TestManager, you must have the following software 
installed:

■ Windows 2000 or Windows NT Version 4.0 with at least Service Pack 4

■ Visibroker (C++ or Java) Version 3.3 or 3.4

IDL

IDL (Interface Definition Language) defines an application’s interfaces, including 
method names, parameters, data types, and exceptions. You can use IDL to map to 
many languages for implementation. To record test scripts in Robot and play back test 
Guidelines and Restrictions 10



scripts in TestManager with methods, parameter names, and data described in a 
meaningful way, you must import the application’s IDL into TestManager before test 
script generation.

To import IDL into TestManager:

■ Click Tools > Interfaces.

■ From the Interfaces dialog box, click Import.

■ From the Select IDL File dialog box, browse to find and choose the IDL file to 
import. 

■ Click OK.

The information imported is stored in the project for use by TestManager at test script 
generation and play back. You will not be able to play back test scripts until the IDL 
has been imported into TestManager. 

TestManager stores the IDL information within the project based on the interface 
name.

If you do not load all the IDL prior to test script generation, some methods may script 
opaquely. That is, method parameter names will not be listed. Instead, only a single 
parameter with the name “*” is listed, and all data is asciified hexadecimal.

Sometimes, IDL files will include other IDL files. If include path information is not 
relative, you may have to specify an IDL include path. You may specify such a path 
using the IDLINCLUDE environment variable. For example, 
IDLINCLUDE=d:\myidl;d:\otheridl.

Recording

Recording of CORBA applications is similar to recording of other environments. Both 
Network and API recording methods are supported. 

Before recording, you must select IIOP in the Generator Filtering tab of the Virtual User 
Record Options dialog box in Rational Robot. IIOP traffic between client and server is 
used to produce VU test scripts.

Test Script Generation

After recording, a VU test script is produced that describes the interactions between 
client and server. There are two common IIOP VU emulation commands:

■ iiop_bind, which describes how to locate an object that supports a certain 
interface.
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■ iiop_invoke, which specifies a method invocation, including parameter names 
and data.

You can limit the scripting of client traffic to a particular computer using the 
LT7_IIOPCLIENTIP environment variable. For example, 
LT7_IIOPCLIENTIP=137.162.195.135.

By default, IDL sequences are scripted with a limit of ten members. You can increase 
this number using the LT7_DEFAULT_SEQUENCE_SIZE environment variable. For 
example, LT7_DEFAULT_SEQUENCE_SIZE=20.

In each case, the variable is set in the Environment tab of the System Properties dialog 
box under the Control Panel.

Playback

Before playback, all interfaces referenced in a test script must have their IDL imported 
into TestManager.

Special IIOP monitoring states are provided for the state histogram monitor window.

Playback of ASCII hex (opaque) data between computers of differing byte ordering is 
not supported. Byte ordering specification is marked in the IIOP protocol. It is 
possible that data may be transferred with big-endian byte order, even on Windows 
NT systems. This case is more likely to occur if the application is Java. The result is 
that data specified opaquely in these cases may not play back correctly, even though 
the recording computer and the playback computer have the same byte order.

Supported and Unsupported Data Types

TestManager supports record and playback of the following data types:

■ char

■ octet

■ short

■ unsigned short

■ long

■ unsigned long

■ float

■ double

■ boolean
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■ enum

■ struct

■ union

■ array

■ sequence

The following data types are not supported, and will result in methods being scripted 
opaquely if they occur as a parameter data type in a method:

■ any

■ long double

■ unsigned long long

■ long long

■ wchar

■ wstring

■ fixed

UNIX Agents

Only Solaris is supported for UNIX Agent playback. The Visibroker bind modus is not 
supported for playback.This limitation means that “Visibroker” cannot be used to 
locate object references at play back. Therefore, another method, such as reading IORs 
(Inter-operable Object Reference) from a file, or specifying them explicitly in VU test 
scripts, must be used to locate objects when playing back test scripts from a Solaris 
Agent.

SQL Anywhere Server

■ In this release, only Rational ClearQuest uses the SQL Anywhere server.

■ During the installation of a SQL Anywhere Server, select Replace these files with 
English equivalents independent of the language environment in which you are 
working. Microsoft recommends this because selected files must be replaced with 
their English equivalents.

■ The SQL Anywhere database treats the \ (backslash) character as an escape 
character. This causes a translation of the backslash character and the subsequent 
character as they are added to the database. For example '\\' becomes '\', and '\n' 
becomes an unprintable character, etc. 
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Rational Administrator

Unified Change Management (UCM)

If you use Unified Change Management (UCM) with Rational Suite under these 
conditions:

■ You use Rational ClearQuest to manage UCM activities, and 

■ You place a RequisitePro project or a Rational Test datastore under configuration 
control

Then make sure that you do not set the UCM policy, "Check Assignment Before Work 
On". (The default is for the policy not to be set.)

When you set the policy, you cannot work on an activity unless you are the owner of 
that activity. But in the current implementation of UCM for RequisitePro and Rational 
Test, an entire team of workers share the same activity. Therefore, if the policy is set, 
only one person, not the entire team, can work in a RequisitePro project or in a 
Rational Test datastore.

If the policy is mistakenly set, you will see the error message "Source control could not 
set activity." To work around this error:

■ Start the Rational Administrator and connect to a Rational project.

■ Right-click the UCM project and click Properties.

■ On the ClearQuest tab, unset the policy.

For further details, see the Rational Suite Administrator’s Guide.

Associating a Rose Test Input Source with a Project

Administrator includes a Configure Project dialog box. This dialog box does not 
associate a Rose test input source with a project. 

To associate a Rose test input source with a project, use the Manage Test Input Types 
dialog box from TestManager. To reach this dialog, click Tools > Manage > Test Input 
Types.

Editing Reports with Long Pathnames

Crystal Reports is used to generate or edit reports. You can run a report regardless of 
the length of its pathname. However, if you attempt to edit a report whose pathname 
is longer than 80 characters, the message “Dictionary not found” appears. This is a 
Crystal Reports restriction. If you must edit a report with a long pathname, ...
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Contacting Rational Technical Support 

If you have questions about installing, using, or maintaining this product, contact 
Rational Technical Support as follows:

Note:  When you contact Rational Technical Support, please be prepared to supply the 
following information:

■ Your name, telephone number, and company name

■ Your computer’s make and model

■ Your operating system and version number

■ Product release number and serial number

■ Your case ID number (if you are following up on a previously-reported problem)

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com 

Europe, Middle 
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4545-201
Netherlands

support@europe.rational.com 

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com 
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